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About this document
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Caution

1 About this document
This document describes the manual commissioning of Nokia InSite GSM Base
Station (BTS) with BTS SW I2.0 and Nokia InSite BTS Manager 2.0. The
document provides instructions on how to use the Nokia InSite BTS Manager’s
Wizard and how to create cross-connections manually.

This document contains the following information:

• Commissioning with Nokia InSite Wizard

• Manual commissioning

• Cross-connections

• Commissioning Report

• Troubleshooting and Fault Reporting

The pin mappings for the LMP cable are described in Installation.

Commissioning tasks concerning any Nokia Base Transceiver Station (BTS) may
be performed only by properly trained and authorised personnel.
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2 Nokia InSite Wizard
Nokia InSite Wizard is a Nokia 9210 Communicator application for
commissioning Nokia InSite Base Stations (BTSs). It is a local management tool
in Nokia's concept of Automatic Picocell Planning (APP). APP introduces a new
and advanced way of BTS commissioning, integration, frequency planning and
parametrisation. Nokia InSite Base Stations can be adapted to the surrounding
radio environment automatically with the APP.

Nokia InSite Wizard is utilized on site to find the initial frequency for a Nokia
InSite BTS at the commissioning phase. The installation engineer scans the radio
signals with Nokia InSite Wizard and sends the results to the NMS/2000 through
the BSS network. The intelligence of frequency allocation lies in the NMS/2000.

Nokia InSite Wizard provides a commissioning engineer also the means of
managing Nokia InSite BTSs locally. Initiation of test BCCH sending and
monitoring, as well as commissioning with Nokia Autoconfiguration are
supported.

Nokia Autoconfiguration is only supported when Nokia InSite BTSs have been
chained into a Nokia InHub Data Service Unit and the commissioning is
performed with Nokia InSite Wizard.

For information on commissioning with Nokia InSite Wizard, please refer to
Nokia InSite Wizard User Manual.
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3 Nokia InSite BTS Management Suite
Nokia InSite BTS Manager is part of the Nokia InSite BTS Management Suite 1.0
software package, which is a collection of applications for the installation,
commissioning and maintenance of Nokia InSite base station. Nokia InSite BTS
Manager is a commissioning tool for Nokia InSite Base Stations (BTSs).

The installation program of Nokia InSite BTS Management Suite 1.0 creates a
Nokia Applications submenu on the Start menu in Windows. Nokia InSite BTS
Manager and all related applications can be launched from this menu. For more
information on the installation, refer to Nokia InSite BTS Manager’s online Help
or the instructions on the Nokia InSite BTS Management Suite 1.0 CD-ROM
case.

3.1 Nokia InSite BTS Manager

This chapter gives instructions on how to get started with Nokia InSite BTS
Manager. It is assumed here that the user knows how to use Windows 95/98 or
NT4.0 operating systems.

The actual procedure for manual commissioning is explained in Chapter 4.

3.1.1 Starting and exiting Nokia InSite BTS Manager

The installation program of the manager SW creates a Nokia InSite BTS Manager
icon on the desktop and defines its parameters. For more information on the
installation, refer to the Nokia InSite BTS Manager online Help or the
instructions on the Nokia InSite BTS Management Suite CD-ROM sleeve.

Start Nokia InSite BTS Manager as follows:

1. Double-click Nokia InSite BTS Manager icon on the desktop.

2. Enter Nokia InSite BTS Manager password if BTS Manager password
checking option is on (only in Windows 95/98 environment).
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3. Enter the BTS password if BTS password checking is on. The software
continues execution only if the BTS accepts the entered password.

Nokia InSite BTS Manager starts with the Supervision, Alarms and BTS
Events windows opened. Also, the software checks the BTS configuration
and displays it in the Supervision window.

If there is no connection to the BTS, only the BTS Events window is
displayed. Check the communications parameters. In this case, check also
that the LMP cable is connected to the same COM port that is defined in
Nokia InSite BTS Manager.

You can define different Manager options with Options command in File menu
when starting to work with Nokia InSite BTS Manager.

Nokia InSite BTS Manager PC must be connected to the BTS in order to make
the BTS password checking possible. If no connection exists, password checking
is not applicable.

To exit Nokia InSite BTS Manager, choose the Exit command on the File menu.

3.1.2 Using Help

Nokia InSite BTS Manager software has a convenient, context-sensitive online
Help facility for getting information about a task you are going to perform, a
feature you might want to know more about, or a command you may want to use.

To get Help

• press F1

• click the Help button on the toolbar

• choose Nokia InSite BTS Manager command on the Help menu or

• click the Help button in any dialog box.

In the Help Topics window you can see three tabbed pages: Contents, Index and
Find.

Contents

The Contents page displays a list of topics organized in books by category.

Index
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The Index page lists keywords in alphabetical order through which different
topics can be reached.

Find

The Find page provides a full-text search functionality that allows you to search
for any word or phrase in the Help file.

To exit Help, press ESC or ALT+F4.

If the BTS is connected, also the Help Topics for Transmission Unit Manager is
available in the Help menu.
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4 Manual Commissioning
This chapter describes how to perform manual commissioning on Nokia InSite
BTS on site with Nokia InSite BTS Manager’s wizard, using a laptop PC with
Nokia InSite BTS Management Suite 1.0 software package.

4.1 Manual commissioning with Nokia InSite BTS
Manager’s Wizard

Manual commissioning is performed with Nokia InSite BTS Manager’s Wizard.

It is assumed here that the site has been created at the BSC. If the site is a new
one, the BCF is in the ‘locked’ state.

Before beginning the commissioning, do the following:

1. Check that the Abis cable is connected to the correct line interface.

Commissioning can be performed without the BSC connection (Abis cable
disconnected, for example). For more information, see step 8 in the actual
commissioning procedure.

2. Check that the Nokia InSite Base Station is powered up.

3. Connect the Nokia InSite BTS Manager PC to the BTS’s LMP port.
DN99256347 © Nokia Networks Oy 15 (40)
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4. Check that you have the required Site IDs (optional) and transmission
capacity tables.

BTS SW has been loaded to the BTS by the manufacturer at the factory. There is
no need to locally load SW to the BTS before commissioning. If the BTS SW is
different from the SW at the BSC, it will be loaded automatically to the BTS
during the commissioning procedure.

Figure 1 shows a chain configuration where Nokia InSite Base Stations are
connected to Nokia InHub Data Service Unit. In this type of configuration, you
can go through the commissioning procedure steps 1-16 with a minimum number
of changes to the default settings. However, if there is a need to change the LIF
Settings or Synchronization Settings, or to create the cross-connections, see also
section 4.2 and Chapter 5.

Figure 1. Chain configuration

Commission the BTS as follows:

1. Start the Nokia InSite BTS Manager by double-clicking the InSite BTS
Manager icon on the desktop.

2. Enter Nokia InSite BTS Manager and BTS passwords, if required.

3. The BCF object in the Equipment view has a ‘BCF commissioning’
symbol (see Figure 2). You can also check the operational state of the BCF
by moving the mouse pointer over the BCF symbol in the Equipment View,
clicking the right mouse button and selecting the BCF Properties
command.

InHub

HDSL1 HDSL2
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Figure 2. ‘BCF commissioning’ symbol

4. Wait until the Transmission menu is shown on the menu bar, and then
choose the Wizard command on the Commissioning menu. Select the
Manual commissioning option and click Next.

Do not use Planned Commissioning option. Nokia InSite BTS Manager has built-
in support for Planned Commissioning option which uses predefined parameters
read from a Site Configuration File, but NMS/2000 does not support it for Nokia
InSite BTS yet. Currently Nokia is not developing Planned Commissioning for
Nokia InSite BTSs further.

Nokia Autoconfiguration is only supported when Nokia InSite BTSs have
been chained into a Nokia InHub Data Service Unit and the commissioning is
performed with Nokia InSite Wizard.

Commissioning can only be performed with a non-commissioned BTS. If the
BTS is already commissioned, you first need to run the Undo Commissioning
procedure from the BTS Commissioning Wizard.
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Figure 3. Manual commissioning option

5. Enter the parameters. All parameters in Set Transmission Parameters
dialog box are optional, except LIF and synchronization settings. See
Figure 4.

The optional parameters are used only in the Commissioning Report. Nokia
InSite BTS Manager does not compare them to those created at BSC.

Click LIF Settings for checking the line interface settings. Correct the
settings, if necessary, and click OK. See section 4.2.1.
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Click Synchronization for checking the synchronization settings. Correct
the settings, if necessary, and click OK. See section 4.2.2.

The Next button remains disabled until you have checked LIF and
synchronization settings.

Click Next after you have checked the parameters.

Figure 4. Transmission parameters
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6. To allocate incoming Abis capacity for the BTS, click the Traffic Manager
button to open the Traffic Manager dialog box (see section 4.3). When
completed, click OK. This will establish a transmission connection
between the BTS and the BSC.

The Wizard will automatically proceed to the next page after you have allocated
the incoming Abis capacity and the BTS is ready for testing.

Figure 5. Traffic Manager button

7. When you click OK in the Traffic Manager, the Transmission
Configuration page reappears. The Back button is disabled, because the
transmission parameters have already been sent to the BTS. If you need to
change any parameters you have specified prior to this point, click Cancel
and run the Undo Commissioning procedure and then re-commission the
BTS with correct parameters.

8. Depending on the status of the Abis connection, proceed either from
substep 1 Abis enabled or substep 2 Abis disabled.
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1. Abis enabled:

During the BTS/BSC start-up scenario the BSC checks the BTS SW
and if it is not the correct one, the BSC loads SW to the BTS. This
loading will take up to 20 minutes depending on the OMUSIG link
speed. If no SW loading takes place, the process will take about 10
seconds.

If SW loading takes place, the BCF is in the SW loading state during
the SW loading operation. This information is shown on the BTS
Events list. When the SW loading from the BSC is completed, the
BCF is reset automatically. This means that the Equipment view
disappears for a few seconds, but after the BTS has started normally,
the commissioning procedure continues automatically.

After the SW checking and/or loading, the BSC sends the
configuration data to the BTS and the BCF enters the ‘Configuring’
state. It can take up to 5 minutes for the oven oscillator to warm up
after the BTS is powered on. When the oven oscillator is ready, the
BTS Events list displays a message.

When the BTS is ready for testing, the Wizard proceeds
automatically to the next page and the BSC runs automatic tests on
the Abis link.

The Abis loop test will take about 1 minute (all channels of the TRX
are tested).

2. Abis disabled:

If the establishment of the BTS/BSC connection does not succeed
(Abis cable is not connected, for example), the BCF remains in the
‘Waiting for LAPD’ state. If you now click Next, the Wizard
displays a message that there is no connection to the BSC and the
BCF remains in the ‘Waiting for LAPD’ state. The message also
asks you if you want to give the Use Current command. If you click
Yes in the message box, the BTS starts to use the BTS SW in the
TRX memory and the Wizard proceeds to the BTS Test Reporting
page after TRX and BCF are in the ‘Configuring’ state. If you click
No in the message box, the BCF remains in the ‘Waiting for LAPD’
state until you connect the Abis cable.

9. If Abis is connected, you will receive reports on the testing. Check the test
results on the BTS Test Reporting page.

Whether or not the Abis is connected, the Nokia InSite BTS Manager
requests the HW reports from the BTS. 10 seconds after the BCF has
entered the ‘Supervisory’ state, the alarms are shown. The Next button will
be enabled. Click Next to proceed.
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Figure 6. Test events

10. Check the BTS Commissioning Report.

11. Type a path and a name for the BTS Commissioning Report in the Save As
field or click Browse to specify the path and the name, if necessary.
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Figure 7. BTS Commissioning Report

12. Click Finish. The Commissioning Report is saved and the Commissioning
Wizard is closed.

The commissioning report should be saved at this point, because it will not be
possible to do it later after the commissioning.

If there is a need to change the routing parameters, see Chapter 5.

At this point you should check the Alarms window for possible alarms
generated during the commissioning. For alarm descriptions, refer to Nokia
InSite Base Station Alarm Descriptions.
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13. If the site was newly created at the BSC, it remains in ‘locked’ state after
the commissioning. If the site is locked from the BSC, the TRX remains in
‘Waiting for system information’ state. The TRX object in the Equipment
view has ‘Waiting for system information’ symbol (see Figure 8). You can
also check the operational state of the TRX by moving the mouse pointer
over the TRX symbol in the Equipment View, clicking the right mouse
button and selecting the TRX Properties command. Request a ‘site unlock’
from the BSC or NMS. After the ‘site unlock’, the BCF is reset
automatically and then enters the ‘Supervisory’ state.

Figure 8. ‘Waiting for system information’ symbol

14. If you want to disable the LEDs, choose ‘Disable LEDs’ on the Objects
menu.

15. Quit Nokia InSite BTS Manager.

16. Disconnect Nokia InSite BTS Manager PC from the Nokia InSite BTS’s
LMP port.

The commissioning parameters are stored in the flash memory of the TRX.

To backup the configuration in Nokia InSite BTS chain(s), it is advisable to use
the Settings Backup dialog in Transmission menu. Select Export to save
transmission and commissioning configuration to a file. In case you need to
replace a BTS, you can select Import with the backup file after installing the new
BTS. This way the new BTS can be set up and recommissioned easily.

Settings Backup shoul be run after all the chained BTS nodes have been
commissioned.

Complete the installation as instructed in Nokia InSite Base Station Installation.

4.2 Setting line interfaces and synchronization

Normally, there is no need to change line interface and synchronization settings.
However, depending on the site configuration, it may be necessary to make
changes to these settings. Following procedures show how the changes are made.
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4.2.1 Setting line interfaces with LIF Settings dialog box

The LIF Settings dialog box is a tool for defining the settings for the line
interfaces used.

Set the LIF settings as follows:

1. Select the uplink line interface (to the BSC direction) page, for example
HDSL, and select the Interface in Use option.

If the interface used is HDSL, select the HDSL mode which is different
from the HDSL mode selected for the other end in the previous unit. HDSL
mode selection affects only the modem handshaking, which is why the
modes have to be different ones for two communicating ends.

If the interface used for uplink direction is E1, select the CRC the way it is
defined in BSC.

TS0 fixed bits from 1 to 3 are reserved for CRC and frame locking. Bits
from 4 to 8 are used for alarms and data transfer in national connections.
The value for TS0 fixed bits is either 1 or 0.

2. Select the outgoing downlink HDSL line interface page, and select the
Interface in Use option. Select the HDSL mode as described above.

3. Select the line interface page for the line interfaces which are not used, and
deselect the Interface in Use option.

4. Select OK for accepting the changes.
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Figure 9. LIF Settings: HDSL

Figure 10. LIF Settings: E1
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4.2.2 Setting synchronization with Synchronization dialog box

The Synchronization dialog box is a tool for defining the settings for the
synchronization.

Set the synchronization settings as follows:

1. Select the Rx clock for timing option and select the interface which is used
for synchronization, for example E1 2M. Normally the uplink line interface
is selected as the synchronization source.

To check whether the selected interface can act as the active synchronization
source, click Apply and then Refresh. If Active Timing is ‘Internal’, the BTS
cannot be in synchronization with the selected interface. During HDSL
handshaking, Active Timing status remains ‘Internal’. To ensure that
synchronization settings are correct, click Refresh again after 30 seconds.

2. Select OK for accepting the changes.

Figure 11. Synchronization Settings
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4.3 Allocating transmission capacity with Traffic
Manager dialog box

The Traffic Manager is a graphical tool that allows you to allocate BTS
transmission capacity. You need only to define the line interface and the
incoming timeslot allocation on the Abis according to the transmission plan.

The cross-connections to this BTS are created automatically after the capacity has
been set and approved.

Figure 12. Traffic Manager for allocating BTS transmission capacity

The capacity to be used is defined by selecting its signal type (TCHs, TRXSIG,
OMUSIG, TRXSIG on TCHs or OMUSIG/TRXSIG) and by reserving required
timeslots and bits. The signal types are explained in more detail later in Section
4.3.1.
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Allocate transmission capacity as follows:

1. Select the uplink line interface used (HDSL1, HDSL2 or E1 interface).

In the case of HDSL, the Traffic Manager automatically reduces the number of
timeslot rows in the table to 16.

2. Click the TCHs button and then click in a cell in the Abis timeslot
allocation table.

3. Select the signalling type and the cell position in the Abis TS Allocation
table.

If you want to modify the allocation table at this point, you have to first delete
prior allocations. Click the right mouse button on the cell to be modified and
delete either one signal allocation, or delete all signal allocations.

4. At this point you can click the Export button to export the Abis timeslot
allocation information to a file for future maintenance purposes.

5. Click the OK button to send the information to the BTS.

When the link capacity restricts normal signal allocation, you can use the
‘TRXSIG on TCHs’ or combined ‘OMUSIG/ TRXSIG’ signal types as shown in
Figure .

4.3.1 Signal types

OMUSIG

The BTS can have one OMUSIG which allocates 2, 4 or 8 bits in one timeslot
depending on the link speed used (16, 32 or 64 kbit/s). If a combined OMUSIG/
TRXSIG is used, the allocation of the OMUSIG is disabled.
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OMUSIG/TRXSIG

The BTS can have one combined OMUSIG/TRXSIG which allocates 2 or 4 bits
in one timeslot depending on the link speed used (16 or 32 kbit/s). When a
compressed Abis timeslot allocation is used, the OMUSIG/TRXSIG can be
located in radio timeslots 1 - 2 (starting from bit 1), which means that it overlaps
at most two TCHs which are reserved for the TRX.

TCHs

All TCHs allocate 2 contiguous timeslots (16 bits) for a single TRX each of which
is marked with the TRX number.

TRXSIG

Each TRXSIG can allocate 2, 4 or 8 bits in one timeslot depending on the link
speed used (16, 32 or 64 kbit/s).

TRXSIG on TCHs

The TRXSIG can be reserved on a traffic channel (TCH) but then up to 2 radio
timeslots (4 bits) are lost. The signal type allocation must always start from the
first bit of the timeslot.
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5 Cross-connections
There is no need to create cross-connections after Abis allocation with the Traffic
Manager, if the default cross-connections have been taken into account when the
sites were created at BSC. However, depending on the site configuration, it may
be necessary to create cross-connections. This procedure is described in Section
5.2.

Nokia InSite BTS has to be commissioned before creating the cross-connections.

5.1 Default cross-connections

Nokia InSite BTS has a set of built-in default cross-connections:

E1 network connection

• Timeslots 1 - 14 are bidirectionally cross-connected from E1 to HDSL1

• Timeslots 15 - 28 are bidirectionally cross-connected from E1 to HDSL2

HDSL network connection

• Timeslot 1 - 16 for HDSL1 are bidirectionally cross-connected to timeslots
1 - 16 for HDSL2
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In E1 case, if timeslots 29 -30 are reserved for the first site, it will be possible to
chain 7 Nokia InSite BTSs through a single HDSL interface using combined and
compressed signalling. Thus the total chain could contain up to 15 Nokia InSite
BTSs. See Figure 13.

Default cross-connections are not visible in the Traffic Manager or the TRU
Manager
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Figure 13. Default cross-connections in E1 network connection

There are no default cross-connections in Nokia InHub Data Service Unit.

5.2 Creating cross-connections

Cross-connections are created with the Cross-connections dialog box in the Nokia
InSite BTS Manager application.

1 1 1 1 1
0 2 1 1 1 1
1 1 1 1 1 3 2 2 2 2
2 1 1 1 1 4 2 2 2 2
3 2 2 2 2 5 3 3 3 3
4 2 2 2 2 6 3 3 3 3
5 3 3 3 3 7 4 4 4 4
6 3 3 3 3 8 4 4 4 4
7 4 4 4 4 9 5 5 5 5
8 4 4 4 4 10 5 5 5 5
9 5 5 5 5 11 6 6 6 6

10 5 5 5 5 12 6 6 6 6
11 6 6 6 6 13 7 7 7 7
12 6 6 6 6 14 7 7 7 7
13 7 7 7 7 15
14 7 7 7 7 16
15 8 8 8 8
16 8 8 8 8
17 9 9 9 9 1 8 8 8 8
18 9 9 9 9 2 8 8 8 8
19 10 10 10 10 3 9 9 9 9
20 10 10 10 10 4 9 9 9 9
21 11 11 11 11 5 10 10 10 10
22 11 11 11 11 6 10 10 10 10
23 12 12 12 12 7 11 11 11 11
24 12 12 12 12 8 11 11 11 11
25 13 13 13 13 9 12 12 12 12
26 13 13 13 13 10 12 12 12 12
27 14 14 14 14 11 13 13 13 13
28 14 14 14 14 12 13 13 13 13
29 15 15 15 15 13 14 14 14 14
30 15 15 15 15 14 14 14 14 14
31 15

16
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Cross-connections define how signals are routed from a BTS to another BTS.
Cross-connections are created into the inactive bank. The cross-connections in
the active bank are in use, whereas those in the inactive bank can be used for
creating or modifying cross-connections. The procedure below describes how to
create bidirectional cross-connections.

Creating bidirectional cross-connections:

1. Choose Cross-connections on the Transmission menu.

2. Select the page of the bank which is inactive. (The number of the active
bank is given above the cross-connections list.)

3. Click the Copy command for copying the active bank into the inactive
bank, and click OK.

4. Open the Add Cross-Connection dialog box by clicking the Add button and
choosing the Add command.

5. Define the following settings according to the cross-connection plan:

• label, i.e. the name of the new cross-connection (max. 80 characters)

• cross-connection type; in this case the type is ‘bidirectional’

• granularity (with n x 64k, set also its coefficient n, = number of
timeslots)

6. Click the Tx1/Rx1 button to open the Add Termination Point dialog box.
The Tx1/Rx1 is the uplink direction.

7. In the Interface tree view, select the uplink transmission interface.

In the timeslot table, the timeslots and bits reserved earlier are indicated by grey,
while the selected ones will become blue.

8. Click a cell in the table to define the start bit of the frame.

9. Click OK. The dialog box is closed.

10. Click the Tx2/Rx2 button to open the Termination Point view. The Tx2/
Rx2 is the downlink direction.

11. In the Interface tree view, select the downlink transmission interface.
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12. Click a cell in the table to define the start bit of the frame.

13. Click OK. The dialog box is closed.

14. Click Apply in the Add Cross-connection dialog box. All settings are
loaded but the window remains open.

15. Repeat steps 5 - 14 for other types of cross-connections.

16. Click OK in the Cross-Connections dialog box.

17. Click Activate command for activating the inactive bank, and click OK.

18. Click Close in the Cross-Connections dialog box.

Modifying cross-connections

You can start to modify existing settings in an inactive bank by clicking the
particular connection in the cross-connection list view in the Cross-connection
dialog box and clicking the Modify command.

If Undo Commissioning procedure is performed, all settings and modifications
will be lost and the cross-connections are reset to their default value. See Section
5.1.
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Commissioning report
6 Commissioning report
At the end of the commissioning procedure, the Commissioning Report is saved
in a file on the PC hard disk. The report is an ASCII text file that you can open
and check with Notepad or any word processor.

The BTS Commissioning report provides the following information:

• Report title, date and time, user name

• Network time

• Commissioning mode

• BTS logical configuration

• Telecom status

• BTS HW report

• BTS SW report

• Abis allocation report

• Abis test report

• BTS alarm test report
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Troubleshooting and fault reporting
7 Troubleshooting and fault reporting
In the case of a failure in the commissioning procedure, check if there is a
corresponding alarm in the Alarms window in Nokia InSite BTS Manager (see
Alarm descriptions) or in Transmission Manager (Alarms in Transmission
menu). Also, you may check the cause of a failure from the commissioning report,
if any failures have been detected during the commissioning.

The most common problems and probable reasons for them are presented in the
following table. See which explanation best describes your problem and act
accordingly.

Table 1. Troubleshooting

Symptom Possible reasons What to do

Continuous Loss of incoming
signal or Loss of frame alignment
alarms in HDSL1 or HDSL2
interfaces.

1. Abis cable is not properly
connected.

2. Wrong HTU mode selected.

1. Check Abis cables.

2. Check HTU mode in LIF
Settings dialog box. The modes
have to be different in the
communicating BTS units.

Continuous Loss of incoming
signal or Loss of frame alignment
alarms in E1 interface.

1. Abis cable is not properly
connected.

2. CRC setting is incorrect.

3. PCM (ET) port is not activated
at BSC.

1. Check E1 Abis cable. Note that
Nokia InHub Data Service Unit
Abis cable pin order differs
from InSite BTS.

2. Check CRC settings against
the settings at BSC.

3. Check ET port status at BSC.

OMUSIG establishment fails 1. Pre-configuration at BSC has
failed, is incorrect or
incomplete.

2. Transmission path is incorrectly
configured.

3. PCM timeslot allocations differ
at BSC and on site.

1. Check BSC configuration
regarding this BTS.

2. Check cross-connections on
the route to BSC.

3. Compare timeslot allocations at
BSC and on site.
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Note

Before starting to re-commission the BTS, first run the Undo Commissioning
procedure. If the Commissioning Wizard has stopped, click Cancel to abort the
commissioning procedure.

Report all damages, failures or faults to Nokia using the Failure Report Form
provided by the Customer Service Center (CSC).
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